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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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The information in this document is current as of March, 2005. The information is subject to change 
without notice.  For actual design-in, refer to the latest publications of NEC Electronics data sheets or 
data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not all 
products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior       
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this document 
or any other liability arising from the use of such products.  No license, express, implied or otherwise, is 
granted under any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application.  The recommended applications of an NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality grade of 
each NEC Electronics product before using it in a particular application.
 "Standard": Computers, office equipment, communications equipment, test and measurement equipment, audio

and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.

"Special": Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).

"Specific": Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)
(1) "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 

majority-owned subsidiaries.
(2) "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics

(as defined above).

•

•

•

•

•

•
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Regional Information

•  Device availability

•  Ordering information

•  Product release schedule

•  Availability of related technical literature

•  Development environment specifications (for example, specifications for third-party tools and
   components, host computers, power plugs, AC supply voltages, and so forth)

•  Network requirements

In addition, trademarks, registered trademarks, export restrictions, and other legal issues may also vary
from country to country.

[GLOBAL SUPPORT]
         http://www.necel.com/en/support/support.html

NEC Electronics America, Inc. (U.S.)
Santa Clara, California
Tel: 408-588-6000
       800-366-9782

NEC Electronics Hong Kong Ltd.
Hong Kong
Tel: 2886-9318

NEC Electronics Hong Kong Ltd.
Seoul Branch
Seoul, Korea
Tel: 02-558-3737

NEC Electronics Shanghai Ltd.
Shanghai, P.R. China
Tel: 021-5888-5400

NEC Electronics Taiwan Ltd.
Taipei, Taiwan
Tel: 02-2719-2377

NEC Electronics Singapore Pte. Ltd.
Novena Square, Singapore
Tel: 6253-8311

J05.6

NEC Electronics (Europe) GmbH
Duesseldorf, Germany
Tel:  0211-65030

• Sucursal en España
Madrid, Spain
Tel:  091-504 27 87

Vélizy-Villacoublay, France
Tel:   01-30-67 58 00

• Succursale Française

• Filiale Italiana
Milano, Italy
Tel:  02-66 75 41

• Branch The Netherlands
Eindhoven, The Netherlands
Tel:   040-265 40 10

• Tyskland Filial
Taeby, Sweden
Tel:  08-63 87 200

• United Kingdom Branch
Milton Keynes, UK
Tel:  01908-691-133

Some information contained in this document may vary from country to country.  Before using any NEC 
Electronics product in your application, pIease contact the NEC Electronics office in your country to 
obtain a list of authorized representatives and distributors.  They will verify: 
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1. INTRODUCTION 
78K0S/KA1+ – Do it! is a starter kit for the NEC Electronics 78K0S/KA1+ microcontrollers. 

It supports onboard FLASH programming and real time execution of application programs up to 4 KB based on the 

78K0S/KA1+ microcontroller.  The board is prepared to be connected to user hardware parts such as digital I/O or 

analogue signals. 

 

1.1 Main Features of 78K0S/KA1+ – Do it! 
• Easy to use device demonstration capabilities 

78K0S/KA1+ - Do it! contains elements to easily demonstrate simple I/O-functions, i.e. push buttons, LED 

output, AD reference voltage, I/O lines, UART interface. 

 

• Power supply via USB interface 

78K0S/KA1+ - Do it! is powered via USB interface, no separate power supply is needed. 

 

• PG-LPC, FLASH programming software 

A windows based FLASH programming software allows to select and download application programs to 

78K0S/KA1+ - Do it! board for evaluation purposes. 

 

• Analogue to digital signal conversion is supported 

 

• Various input/output signals available, such as 

 

° All I/O ports prepared to be connected to user hardware 

° Timer input/output signals 

° UART interface, via USB UART chip FT232 

° 4 analogue input lines 

° 4 I/O ports connected to LEDs 

° 1 push button prepared for external interrupt generation 

 

78K0S/KA1+ - Do it! is not intended for code development.  NEC Electronics does not allow and does not 

support in any way any attempt to use 78K0S/KA1+ - Do it! in a commercial or technical product. 
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1.2 System Requirements 
 

HOST PC The assembler, C compiler, system simulator, and FLASH programming software require a 

PC running Windows 98SE, Windows Me, Windows 2000, or Windows XP.  

A Pentium II 400 MHz CPU, 128 MB or more of RAM, 256-color display (800 × 600), mouse, 

CD-ROM drive, and a minimum of 90 MB of free hard disk space are required for installation.  

 

Host interface USB interface that enables communication based on USB (Ver1.1 or later) 

 

 

1.3 Package Contents 
Please verify that you have received all parts listed in the package contents list attached to the  

78K0S/KA1+ - Do it! package.  If any part is missing or seems to be damaged, please contact the dealer from 

whom you received your 78K0S/KA1+ - Do it!. 
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2. 78K0S/KA1+ - Do it! SYSTEM CONFIGURATION 
The 78K0S/KA1+ - Do it! system configuration is given in the diagram below: 

 

 

Figure 2-1.  78K0S/KA1+ - Do it! System Configuration  

 

2.1 78K0S/KA1+ - Do it! 
78K0S/KA1+ - Do it! is a starter kit for the NEC Electronics 78K0S Low Pin Count devices.  The µPD78F9222 

microcontroller is a typical device from this family and it has been used to realize the 78K0S/KA1+ - Do it!. 

 

The 78K0S/KA1+ - Do it! board is connected to the host system via USB interface cable.  The host 

system may be used for programming of µPD78F9222 FLASH memory and to allow execution of application 

programs on 78K0S/KA1+ - Do it! platform. 

 

78K0S/KA1+ - Do it! runs the µPD78F9222 microcontroller at 8.00 MHz operating speed.  

 

2.2 Host Computer 
The USB host interface enables communication to the 78K0S/KA1+ - Do it! board.  The USB UART chip FT232 

allows application software to access the USB device in the same way as it would access a standard RS232 

interface.  The FTDI’s Virtual COM Port (VCP) driver appears to the windows system as an extra Com Port, in 

addition to any existing hardware Com Ports.  

 

For a detailed specification of the host interface please refer to the chapter 12. CONNECTORS AND CABLES of 

this document. 

 

2.3 Power Supply via USB Interface 
78K0S/KA1+ - Do it! is powered by USB interface, no separate power supply is needed.  The USB interface 

provides the 78K0S/KA1+ - Do it! board with 5 V supply voltage. 
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3. 78K0S/KA1+ - Do it! BOARD COMPONENTS 
The 78K0S/KA1+ - Do it! board is equipped with push buttons, LEDs and with several connectors in order to be 

connected to host computers or connect any target hardware.  Additionally the 78K0S/KA1+ - Do it! board provides a 

wire wrap field (2,54 mm grid) to integrate user application hardware. 

 

 

Figure 3-1.  78K0S/KA1+ - Do it! Board Connectors, Switches, and LEDs  

 

All of the 78K0S/KA1+ - Do it! µPD78F9222 on-chip resources are free for user application hardware and 

software.  Please read the user’s manual of the 78K0S/KA1+ device carefully to get information about the electrical 

specification of the available I/O ports before you connect any external signal to the 78K0S/KA1+ - Do it! board! 

 

3.1 Configuration Switch SW3 
The different operation modes of the 78K0S/KA1+ - Do it! board can be set by SW3 switches S1 to S4.  

 

Table 3-1.  Configuration Switch SW3, Factory Settings  

SW3 Factory Settings Function 

S1 OFF Normal operation mode 

S2 OFF No UART 

S3 OFF CPU clock = 8 MHz 

S4 OFF No handshake for UART 
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3.1.1 Operation mode selection SW3/S1 

SW3 switch S1 controls the operation mode of the 78K0S/KA1+ - Do it! board.  Setting SW3/S1 to ON allows to 

reprogram the internal FLASH memory of the 78K0S/KA1+ device using the PG-LPC FLASH programming software. 

 

Table 3-2.  Operation Mode Selection SW3/S1  

SW3, S1 Operation Mode 

OFF (default) Normal operation mode 

ON FLASH memory programming mode 

 

Within normal operation mode the user program stored in the FLASH memory of 78K0S/KA1+ device is executed. 

 

3.1.2 UART selection SW3/S2 

SW3 switch S2 controls the serial communication of 78K0S/KA1+ - Do it! board.  The UART6 signals RxD6 and 

TxD6 are connected to the FT232 interface lines when setting SW3/S2 to ON. 

 

Table 3-3.  UART Selection SW3/S2  

SW3, S2 Operation Mode 

OFF (default) RxD6/TxD6 disconnected 

ON RxD6/TxD6 connected to FT232 interface lines 

 

3.1.3 Clock mode selection SW3/S3 

SW3 switch S3 controls the clock operation frequency of the 78K0S/KA1+ - Do it! board.   

 

Table 3-4.  Clock Mode Selection SW3/S3  

SW3, S3 Operation Mode 

OFF (default) Clock frequency = 8 MHz 

ON Clock frequency = 4 MHz 

 

3.1.4 UART mode selection SW3/S4 

SW3 switch S4 controls the UART communication mode of 78K0S/KA1+ - Do it! board.  Setting SW3/S4 to ON 

enables UART communication with handshake.  Within this mode the CPU pins P40 and P41 are connected to the 

FT232 interface lines and used as RTS and CTS control signals. 

 

Table 3-5.  UART Mode Selection SW3/S4  

SW3, S4 Operation Mode 

OFF (default) UART communication without handshake 

ON UART communication with handshake 

(P40 = RTS; P41 = CTS) 
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3.2 User Button SW1 
SW1 is a push button connecting VSS to external interrupt input INTP0 of the CPU.  This is equal to port P30 of the 

78K0S/KA1+ CPU.  The port may be programmed to generate interrupt INTP0.  The necessary initialisation for this 

purpose is described in the user’s manual of the 78K0S/KA1+ device.  Pressing this button will apply low signal level 

at port P30. 

 

3.3 Start Button SW2 
SW2 is a reset button.  It activates the power on reset.  It is connected to the reset input of the CPU.  Pressing this 

button will apply low signal level at the RESET pin. 

 

3.4 USB Interface Connector CN7 
CN7 connector allows connecting the PG-LPC FLASH programming software to the 78K0S/KA1+ - Do it! board in 

order to program application programs into the CPU internal flash.  The board power supply of 5V is also provided by 

connector CN7. 

 

Additionally connector CN7 connects UART6 of the 78K0S/KA1+ device to the host system. 

 

3.5 Connector CN1/Clock Configuration 
Connector CN1 is used to define the operating clock of the 78K0S/KA1+ - Do it! board.  Shorting the connectors 

CN1/3-5 and CN1/4-6 (default setting) provides 8 MHz clock frequency to the 78K0S/KA1+ device.  In this mode the 

clock frequency is supplied by the CPLD. 

 

Alternative an external crystal oscillator can be equipped to the 78K0S/KA1+ - Do it! board.  To use this operation 

mode short connectors CN1/1-3 and CN1/2-4. 

 

Table 3-6.  Connector CN1, Clock Configuration  

CN1 Jumper Setting  Mode 

1-2 

3-5 

4-6 

Open (default) 

Shorted (default) 

Shorted (default) 

Clock frequency = 8 MHz, supplied by CPLD 

1-3 

2-4 

5-6 

Shorted 

Shorted 

Open 

Clock supply by external oscillator.  By using this mode be 

sure to equip a crystal oscillator and corresponding capacitors 

to X1, C12 and C11. 
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3.6 Connectors CN2/CN12/External Peripheral Configuration  
Connectors CN2 and CN12 allow connecting and disconnecting of the external board hardware to the 

78K0S/KA1+ device. 

 

Table 3-7.  Connector CN2, External Peripheral Configuration  

CN2 Jumper Setting Mode 

1-2 Shorted (default) RESET pin connected to CPLD 

3-4 Shorted (default) RESET pin connected to button SW2 

5-6 Shorted (default) INTP0 pin connected to button SW1 

7-8 Shorted (default) P40 connected to CPLD (RTS line of FT232) 

9-10 Shorted (default) P41 connected to CPLD (CTS line of FT232) 

 

Table 3-8.  Connector CN12, External Peripheral Configuration  

CN12 Jumper Setting Mode 

1-2 Shorted (default) Power supply, Vcc = 5 V connected to 78K0S/KA1+ and 

external potentiometer R24 

3-4 Shorted (default) AVREF pin connected to Vcc  

5-6 Shorted (default) ANI0 pin connected to R24 potentiometer arm 

7-8 Shorted (default) P44/RxD6 connected to CPLD (RxD line of FT232) 

9-10 Shorted (default) P43/TxD6 connected to CPLD (TxD line of FT232) 

 

 

3.7 External Potentiometer R24 
A 10k potentiometer R24 is connected between Vcc and ground.  Vcc is supplied to R24 by shorting connector 

CN12/1-2.  The potentiometer arm can be connected to the ANI0 analogue input of the 78K0S/KA1+ device by 

shorting connector CN12/5-6. 

 

3.8 AD Converter Reference Voltage Input 
The reference voltage of the potentiometer R24 can be supplied to the AVREF input by shorting connector  

CN12/3-4. 

 

3.9 External LEDs D1 to D4 
The LEDs D1 to D4 are connected to the 78K0S/KA1+ device and are free for user application purposes.  The 

LEDs are connected via a 4.7k pull-up resistor to Vcc and therefore active low. 

 

Table 3-9.  Connection of LEDs D1 to D4  

Port LED 

P23 D1 

P130 D2 

P45 D3 

P123 D4 

 

For disconnecting a LED from a port for alternative usage cut the connection (default) of the corresponding 

soldering bridges SB1 to SB4. 
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3.10 External Connectors CN3,CN4, CN5, and CN6 
CN3, CN4, CN5, and CN6 are connectors for external user hardware.  All CPU signals are connected to CN3, with 

the exception of X1 and X2 signals.  The 78K0S/KA1+ - Do it! board provides a wire wrap field - connectors CN4, 

CN5 and CN6 - allowing the integration of additional application hardware.   

 

Table 3-10.  External Connectors CN3, CN4, CN5 and CN6 

CN3  CN3   CN6  CN6   CN5  CN5   CN4  CN4  

39 VCC 40 AVREF  39 N.C. 40 N.C.  39 N.C. 40 N.C.  2 N.C. 1 GND 

37 VCC 38 P20  37 N.C. 38 N.C.  37 N.C. 38 N.C.  4 N.C. 3 GND 

35 VCC 36 P21  35 N.C. 36 N.C.  35 N.C. 36 N.C.  6 N.C. 5 GND 

33 VCC 34 P22  33 N.C. 34 N.C.  33 N.C. 34 N.C.  8 N.C. 7 GND 

31 VCC 32 P23  31 N.C. 32 N.C.  31 N.C. 32 N.C.  10 N.C. 9 GND 

29 VCC 30 P130  29 N.C. 30 N.C.  29 N.C. 30 N.C.  12 N.C. 11 GND 

27 VCC 28 P45  27 N.C. 28 N.C.  27 N.C. 28 N.C.  14 N.C. 13 GND 

25 VCC 26 P44  25 N.C. 26 N.C.  25 N.C. 26 N.C.  16 N.C. 15 GND 

23 VCC 24 P43  23 N.C. 24 N.C.  23 N.C. 24 N.C.  18 N.C. 17 GND 

21 VCC 22 P42  21 N.C. 22 N.C.  21 N.C. 22 N.C.  20 N.C. 19 GND 

19 VCC 20 P41  19 N.C. 20 N.C.  19 N.C. 20 N.C.  22 N.C. 21 GND 

17 VCC 18 P40  17 N.C. 18 N.C.  17 N.C. 18 N.C.  24 N.C. 23 GND 

15 VCC 16 P30  15 N.C. 16 N.C.  15 N.C. 16 N.C.  26 N.C. 25 GND 

13 VCC 14 P31  13 N.C. 14 N.C.  13 N.C. 14 N.C.  28 N.C. 27 GND 

11 VCC 12 RESET  11 N.C. 12 N.C.  11 N.C. 12 N.C.  30 N.C. 29 GND 

9 VCC 10 VDD  9 N.C. 10 N.C.  9 N.C. 10 N.C.  32 N.C. 31 GND 

7 VCC 8 P123  7 N.C. 8 N.C.  7 N.C. 8 N.C.  34 N.C. 33 GND 

5 VCC 6 N.C.  5 N.C. 6 N.C.  5 N.C. 6 N.C.  36 N.C. 35 GND 

3 VCC 4 N.C.  3 N.C. 4 N.C.  3 N.C. 4 N.C.  38 N.C. 37 GND 

1 VCC 2 VSS  1 N.C. 2 N.C.  1 N.C. 2 N.C.  40 N.C. 39 GND 

 

(N.C. = Not Connected) 
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4. 78K0S/KA1+ MEMORY MAP 
The memory layout of the µPD78F9222 4 KB FLASH ROM device is shown in the table below. 

 

Table 4-1.  78K0S/KA1+ Memory Map 

0xFFFF   

 SFR area  

 256 x 8 bits  

0xFF00  Free for application 

0xFEFF  software 

 Internal high-speed RAM  

 256 x 8 bits  

0xFE00   

0xFDFF   

   

 Use prohibited  

   

0x1000   

0x0FFF   

 Flash memory Free for application  

 4096 x 8 bits software 

A
dd

re
ss

  a
re

a 

0x0000   

 

The 78K0S/KA1+ - Do it! board does not reserve any resources of the 78K0S/KA1+ device, consequently all 

available memory of the device is free for application software. 
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5. 78K0S/KA1+ Do it! HARDWARE AND SOFTWARE 
This starter kit consists of a Do it! board on which the KA1+ is mounted and Windows-based software. Correct and 

effective use of the kit requires the proper installation and setting of the hardware and software. The following 

software is required for this kit.   

 

• RA78K0S: Assembler, integrated development environment  

This is the basic language tool package.  The assembler install package includes an integrated development 

environment (PM+). Be sure to install this software even if developing in C language.   

 

• CC78K0S: C compiler   

This package is required to perform development in C language.   

 

• SM+ for 78K0S/Kx1+: System simulator  

The system simulator is software that allows the operation of a microcontroller to be simulated on a PC.  Thus 

the operation of a microcontroller can be checked on a PC prior to downloading a program to the actual 

machine.  

 

• DF789234: Device file  

The device file is a file that contains the information specific to the microcontroller.  It is required when using the 

assembler, C compiler, and system simulator.  

 

• PG-LPC: FLASH programming GUI   

This is dedicated programming software used to write to the FLASH memory of the KA+ included in this starter 

kit.   

 

• Applilet: Device driver configurator  

This software automatically generates the initial settings and control APIs for the peripheral functions (timer, 

A/D, etc.) of the 78K0S/KA1+.  Since this is not a mandatory tool, its installation procedure and use are not 

covered in this manual.  A simple description of this software is included in the FLP2_QuickGuide_v120.pdf file 

in the supplied CD-ROM.  Please refer to this file for details.   

 

Install the above-listed software products from the supplied CD-ROM.  

Alternatively, these software products can be downloaded from the NEC Electronics website 

(http://www.necel.com/micro/index_e.html).   

 

The software installation procedure is described next.   
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6. SOFTWARE INSTALLATION 
When the supplied CD-ROM is set in the CD-ROM drive of the PC, the Do it! installation program (Doit_install.exe) 

starts automatically.   

 

 

Figure 6-1.  Do it! Installation Program Window   

 

6.1 Installation of Assembler and Integrated Development Environment PM+   
To install the assembler package, which includes integrated development environment PM+, either press the  

 RA78K0S: 78K0S Assembler package  button of the Do it! installation program, or double-click ra78K0s_wxxx_e.exe 

from Explorer. This starts the RA78K0S installer.   

* The xxx part corresponds to the version number.   

 

1. Check and select the software products to be Installed.  

 

Figure 6-2.  RA78K0S Installer Window   
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2. Specify the installation destination and press the  Install…  button. The following message is then 

displayed. Click  OK .  

 

Figure 6-3.  Assembler Installation Start Window  

 

3. Once the License Agreement window is displayed, click  Yes  after reading the contents of the agreement.   

 

 

Figure 6-4.  License Agreement Window  

 

4. Once the product ID input window is displayed, enter the 9-digit product ID, and then click  Next > .  

 * For the product ID, refer to the Readme file.   

 

 

Figure 6-5.  Product ID Input Window  

Click. 

Click.  

Enter 9-digit ID. 
Click. 
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5. Once the installation completion message is displayed, click  OK .   

 

 

Figure 6-6.  Installation Completion Window  

 

6.2 Installation of C Compiler  
To perform development in C language, the C compiler must be installed. Either press the  CC78K0S: 78K0S 

Compiler package  button in the Do it! installation program, or double-click cc78k0s_wxxx_e.exe from Explorer to 

launch the CC78K0S installation.   

* The xxx part corresponds to the version number.  

 

1. Check and select the software products to be installed. 

 

 

Figure 6-7.  CC78K0S Installer Window  

 

2. Specify the installation destination and then press the  Install…  button. When the following message is 

displayed, click  OK .   

 

 

Figure 6-8.  C Compiler Installation Start Window  

Click. 

Click. 
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3. Once the license agreement window is displayed, read the agreement and then click  Yes .   

* The remainder of the installation procedure is the same as that for the assembler and integrated 

development environment PM+.   

4. The product ID input window is then displayed. Enter the product ID and then click  Next > .  

* The product ID of the C compiler differs from that of the assembler and integrated development 

environment.   

5. Once the installation complete message is displayed, click  OK .   
 

6.3 Installation of System Simulator   
Either press the  SM+ for 78K0S/Kx1+: System Simulator  button of the Do it! installation program, or double-click 

sm+for78K0s_kx1+_wxxx_e.exe* from Explorer to launch the 78K0S/Kx1+ installer.   

*  The xxx part corresponds to the version number. 
 

1. Check and select software products to be Installed.  

 

Figure 6-9.  SM+ for 78K0S/Kx1+ Installer Window   

 

2. Specify the installation destination and press the  Install…  button. The following message is then 

displayed.  Click  OK . 

 

Figure 6-10.  System Simulator SM+ Installation Start Window  

 

3. Once the license agreement window is displayed, click  Yes  after reading the contents of the agreement.   

* The remainder of the installation procedure is the same as that for the assembler and integrated 

development environment PM+.   

4. The product ID input window is then displayed. Enter the product ID and then click  Next > .  

* The product ID of the SM+ differs from that of the assembler and integrated development environment, 

and that of the C compiler.  

5. Once the installation complete message is displayed, click  OK .   

Click. 
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6.4 Installation of Device File  
Either press the  DF789234: Device file  button of the Do it! installation program or double-click setup.exe located 

under the df789234 folder from Explorer to launch the device file installer.   

 

1. The welcome message is displayed. Click  Next > .   

 

 

Figure 6-11.  Device File Installation Start Window  

 

2. Once the software license window is displayed, click  Yes  after reading the contents of the license.   

 

 

Figure 6-12.  Software License Window  

Click. 

Click. 
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3. Select DF789234 in the component selection window and then press the  Next >  button.   

 

 

Figure 6-13.  Component Selection Window  

 

4. The file copy start window is displayed. Verify the contents and then click  Next > .   

 

 

Figure 6-14.  File Copy Start Window   

 

Click.

Click.
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5. Once the setup completion window is displayed, click  Finish  to complete the installation.   

 

 

Figure 6-15.  Setup Completion Window   

 

6.5 Installation of PG-LPC FLASH Programming GUI  
Either press the  PG-LPC: FLASH Programmer  button of the Do it! installation program, or double-click setup.exe 

located under the pg-lpc folder from Explorer to launch the PG-LPC FLASH programming GUI installer.  

 

1. Once the setup program is launched, click  Next > .   

 

 

Figure 6-16.  PG-LPC Setup Start Window  

 

Click.

Click. 
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2. The following window is displayed, showing the license agreement. After reading the contents of the license 

agreement, click  Accepted .   

 

 

Figure 6-17.  License Agreement Window   

 

3. Next, the window for specifying the location where the PG-LPC GUI software is to be installed is displayed. 

The default installation destination is C:\Program Files\NECTools32\PG-LPC. To use this default, click  

 Next > . To change the installation destination, click  Browse…  and change the installation destination.   

 

 

Figure 6-18.  Installation Destination Specification Window  

 

Click. 

Click. 
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4. The window for specifying the installation destination for the program menu is displayed. Click  Next > .   

 

 

Figure 6-19.  Program Folder Selection Window  

 

5. The window for confirming the installation destination is displayed. If the set items are correct, click  Next > .   

 

 

Figure 6-20.  File Copy Start Window  

 

Click. 

Click. 
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6. File copying starts. When file copying is completed, click  Finish >  to complete the installation procedure.   

 

 

Figure 6-21.  Setup Completion Window  

 

During the PG-LPC GUI installation, the parameter file for KA1+ (µPD78F9222) is automatically installed to <PG-

LPC install-path>\PRM folder. The latest version of the parameter file (PRM78F9234) can be downloaded from the 

following NEC Electronics microcontroller website.   

 

 http://www.necel.com/micro/ods/eng/index.html 

 

* Download PRM78F9234 by following [ParameterFile PG-FP4 PG-FPLx] and [ParameterFile PG-FP4  PG-

FPLx For 78K0S Series] from Development tools download (ODS) (above URL).  

Click. 
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6.6 Driver Installation 
When 78K0S/KA1+ - Do it! board is used, the driver needs to be installed on the host machine.  After the PG-LPC 

FLASH programming software has been installed successfully a new folder “C:\Program Files\NECTools32\PG-

LPC\DRIVERS” was generated, containing the necessary drivers.  Install the driver according to the following 

procedure: 

 

Installation on Windows 98SE/Me ........... Page 27 

Installation on Windows 2000 .................. Page 29 

Installation on Windows XP ..................... Page 35 

 

6.6.1 Installation on Windows 98SE/Me 

 

1. When the 78K0S/KA1+ - Do it! board is connected with the host machine, the board is recognized by Plug 

and Play, and the wizard for adding new hardware is started.  Click  Next > . 

 

 

Figure 6-22.  Add New Hardware Wizard (Windows 98SE) 

 

2. The window below is displayed.  So, check that “Search for a suitable driver ...” is selected, then click  

 Next > . 

                                      

Figure 6-23.  Search Method (Windows 98SE) 

Click. 

Check that “Search 

for a suitable driver 

...” is selected. 

Click. 
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3. Check the “Specify a location” check box only and enter “C:\Program Files\NECTools32\PG-

LPC\DRIVERS” in the address bar, then click  Next > . 

 

                          

Figure 6-24.  Search Location Specification (Windows 98SE) 

 

Remark If the installation destination folder is changed at the time of PG-LPC software installation, enter 

“new-folder\PG-LPC\DRIVERS”. 

 

4. The window below is displayed.  Click  Next > . 

 

 

Figure 6-25.  Checking Driver to Be Installed (Windows 98SE) 

 

<1> Check “Specify 

a location” only. 

<3>  Click. 

<2>  Enter “C:\Program Files\NECTools32\PG-LPC\drivers”. 

Click. 
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5. When the window below is displayed, the installation of the USB driver is completed.  Click  Finish .  The 

installation of the USB Serial Port driver is then automatically performed. 

 

 

Figure 6-26.  Installation Completion (Windows 98SE) 

 

6.6.2 Installation on Windows 2000 

 

1. When the 78K0S/KA1+ - Do it! board is connected with the host machine, the board is recognized by Plug 

and Play, and the wizard for finding new hardware is started.  Click  Next > . 

 

 

Figure 6-27.  Found New Hardware Wizard 1 (Windows 2000) 

Click. 

Click. 
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2. The window below is displayed.  So, check that “Search for a suitable driver ...” is selected, then click  

 Next > . 

 

 

Figure 6-28.  Search Method 1 (Windows 2000) 

 

3. Check the “Specify a location” check box only, then click  Next > . 

 

 

Figure 6-29.  Driver File Location 1 (Windows 2000) 

 

 

Click. 

Check that “Search for a 

suitable driver ...” is selected. 

Click. 

Check that “Specify a 

location” only is checked. 
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4. Enter “C:\Program Files\NECTools32\PG-LPC\DRIVERS” in the address bar, then click  OK . 

 

 

Figure 6-30.  Address Specification 1 (Windows 2000) 

 

Remark If the installation destination folder is changed at the time of PG-LPC GUI software installation, 

enter “new-folder\PG-LPC\DRIVERS”. 

 

5. Click  Next > . 

 

Figure 6-31.  Driver File Search 1 (Windows 2000) 

 

 

Enter “C:\Program Files\NECTools32\PG-LPC\drivers”. 

Click. 

Click. 
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6. Click  Finish  to complete the installation of the USB driver. 

 

 

Figure 6-32.  USB Driver Installation Completion 1 (Windows 2000) 

 

7. Proceed to the installation of the USB Serial Port driver.  Click  Next > . 

 

 

Figure 6-33.  Found New Hardware Wizard 2 (Windows 2000) 

 

Click. 

Click. 
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8. The window below is displayed.  So, check that “Search for a suitable driver ...” is selected, then click  

 Next > . 

 

                    

Figure 6-34.  Search Method 2 (Windows 2000) 

 

9. Check the “Specify a location” check box only, then click  Next > . 

 

                    

Figure 6-35.  Driver File Location 2 (Windows 2000) 

 

Click. 

Check that “Search for a 

suitable driver ...” is selected. 

Click. 

Check that “Specify a 

location” only is checked. 
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10. Enter “C:\Program Files\NECTools32\PG-LPC\DRIVERS” in the address bar, then click  OK . 

 

 

Figure 6-36.  Address Specification 2 (Windows 2000) 

 

Remark If the installation destination folder is changed at the time of PG-LPC GUI software installation, 

enter “new-folder\PG-LPC\DRIVERS”. 

 

11. Click  Next > . 

 

 

Figure 6-37.  Driver File Search 2 (Windows 2000) 

 

Enter “C:\Program Files\NECTools32\PG-LPC\drivers”. 

Click. 

Click. 
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12. Click  Finish  to complete the installation of the USB driver. 

 

 

 

Figure 6-38.  USB Driver Installation Completion 2 (Windows 2000) 

 

6.6.3 Installation on Windows XP 

 

1. When the 78K0S/KA1+ - Do it! board is connected with the host machine, the board recognized by Plug and 

Play, and the wizard for finding new hardware is started.  Check that “Install from a list or specific ...” is 

selected, then click  Next > . 

 

 

Figure 6-39.  Found New Hardware Wizard 1 (Windows XP) 

 

 

Click. 

Check that “Install from a list 

or specific ...” is selected. Click. 
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2. Check that “Search for the best driver in these locations.” is selected.  Check the “Include this location in the 

search:” check box and enter “C:\Program Files\NECTools32\PG-LPC\DRIVERS” in the address bar, then 

click  Next > . 

 

 

Figure 6-40.  Search Location Specification 3 (Windows XP) 

 

3. As shown below, “has not passed Windows Logo testing to verify its compatibility with Windows XP.” is 

displayed.  Click  Continue Anyway . 

 

 

Figure 6-41.  Windows XP Logo Testing 3 (Windows XP) 

 

<1> Check that “Search 

for the best driver in 

these locations.” is 

selected. 

<2> Check “Include this 

location in the 

search:” only. 

<4>  Click. 

<3>  Enter “C:\Program Files\NECTools32\PG-LPC\drivers”. 

Click. 
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4. When the window below is displayed, the installation of the USB driver is completed.  Click  Finish . 

 

 

Figure 6-42.  USB Driver Installation Completion 1 (Windows XP) 

 

5. Proceed to the installation of the USB Serial Port driver.  Click  Next > . 

 

 

Figure 6-43.  Found New Hardware Wizard 2 (Windows XP) 

 

 

 

Click. 

Check that “Install from a list 

or specific ...” is selected. 
Click. 
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6. Check that “Search for the best driver in these locations.” is selected.  Check the “Include this location in the 

search:” check box and enter “C:\Program Files\NECTools32\PG-LPC\DRIVERS”, then click  Next > . 

 

                         

Figure 6-44.  Search Location Specification 2 (Windows XP) 

 

7. As shown below, “has not passed Windows Logo testing to verify its compatibility with Windows XP.” is 

displayed.  Click  Continue Anyway . 

 

 

Figure 6-45.  Windows XP Logo Testing 2 (Windows XP) 

 

<4>  Click. 
<3>  Enter “C:\Program Files\NECTools32\PG-LPC\drivers”. 

<1> Check that “Search for the 

best driver in these 

locations.” is selected. 

<2> Check “Include 

this location in 

the search:” only. 

Click. 
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8. When the window below is displayed, the installation of the USB driver is completed.  Click  Finish . 

 

 

Figure 6-46.  USB Serial Port2 Driver Installation Completion (Windows XP) 

 

 

 

Click. 
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6.7 Confirmation of USB Driver Installation 
After installing the two types of USB drivers, check that the drivers have been installed correctly, according to the 

procedure below.  When using the 78K0S/KA1+ - Do it! board, the information to be checked here is needed. 

 

By clicking the “Device Manager” tab, check that the drivers are installed correctly. 

 

 

Figure 6-47.  Device Manager 

 

For Windows 98SE/Me 

Caution Do not select  Update  and  Erase  when communicating with the 78K0S/KA1+ - Do it! board. 

 

For Windows 2000/XP 

Caution Do not perform “Hardware Modification Scan” when communicating with the 78K0S/KA1+ - Do it! 
board. 

 

Remark In the GUI port list box, the same communication port as COM? of USB Serial Port (COM?) needs to be 

selected. 

 

 If the drivers above are not displayed, or the mark “×“ or “!” is prefixed, refer to chapter 10 

TROUBLESHOOTING. 

 

Check that “USB Serial 

Port (COM?)” is present. 

Check that “USB High Speed 

Serial Converter” is present. 
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6.8 Driver Uninstallation 
The driver uninstallation program is installed on the host machine when the PG-LPC software is installed.  

 

Use the procedure below for driver uninstallation. 

 

1. When using Windows 2000 or Windows XP, log on as computer administrator. 

 

2. Double-click in the order from “My Computer” to “(C:)” to “Program Files” to “NECTools32” to “PG-LPC” to 

“DRIVERS”.  “Ftdiunin.exe” is displayed.  Double-click “Ftdiunin.exe”. 

 

 

Figure 6-48.  Driver Uninstallation 

 

3. Click  Continue . 

 

 

 

Figure 6-49.  Driver Uninstaller 

 

Double-click. 

Click. 
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4. Click  Finish  to complete driver uninstallation. 

 

 

Figure 6-50.  Completion of Driver Uninstallation 

 

Caution If the PG-LPC software is uninstalled earlier, “Ftdiunin.exe” is also deleted.  In such a case, 
delete “USB Serial Port (COM?)” and “USB High Speed Serial Converter” from Device 
Manager manually. 

 

Click. 



78K0S/KA1+ – Do it!  

User’s Manual  U17514EJ2V0UM 43

 

7. INTEGRATED DEVELOPMENT ENVIRONMENT PM+ AND SYSTEM 
SIMULATOR SM+  

This chapter describes the basic operation of integrated development environment PM+ and system simulator 

SM+ for 78K0S_Kx1+ (hereafter, SM+), using the execution of a sample program.  The environment assumed in this 

chapter is described below.   

 

Used sample name: Light_Demo   

Used workspace: Light_Demo.prw  

Sample program folder: C:\SamplePrograms\Light_Demo  

 

* For the sample program details, refer to chapter 11.  It is assumed that the sample program will be copied from 

the CD-ROM and expanded in the above-listed folder.  If it is copied and expanded to a different folder, read 

the path accordingly.   

 

7.1 Start and Compilation of PM+   
 

1. Start PM+. In the case of the regular installation method, PM+ can be started by clicking  Start  -  Program  

-  NECTools32  -  PMplus .   

 

 

Figure 7-1.  PM+ Startup  
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2. Once PM+ is started, a window such as the one shown in Figure 2 is displayed. Click  File  -  

 Open Workspace  from the pull-down menu and open the workspace selection dialog box.   

 

 

Figure 7-2.  PM+ Startup  

 

3. Specify C:\SamplePrograms\Light_Demo\Light_Demo.prw and then click  Open .  

 

 

Figure 7-3.  Workspace Selection Dialog Box  

 

4. A list of the related files and functions is displayed in the Project Window.  When a file or function is clicked, 

a description of that file or function is displayed in the source window.  To edit a program, write directly in 

the source window.   

 

Click.  
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5. To perform program compilation and assembly, click   (build icon) .   

 

 
 

Figure 7-4.  PM+ Configuration and Compilation   

 

6. Once compilation and assembly are completed, “Build completed normally.” is displayed. Click the  OK  

button. If an error occurred, “A build error was found.” is displayed. In this case, correct the error by 

referring to the message in the Output window.   

 

 

Figure 7-5.  Compilation and Assembly Results  

 

Build icon 

ProjectWindow Source window 

Click.  
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7.2 SM+ Startup and Simulation Execution   
 

1. To start SM+, click   Simulator Start Icon  of PM+.   

 

 

Figure 7-6.  SM+ Start  

 

2. Once SM+ has started, a window such as the one shown in Figure 7 is displayed. Operations such as 

executing and stopping the program are performed by clicking the various execution buttons 
 displayed in the top left part of the screen.   

 

                             
 
 

Figure 7-7.  SM+ Configuration   

3. To execute the program, press the  button. Once execution starts, the cursor in the source window can 

be used and the location of the source file that is executed can be checked. The I/O panel shows a 

simulation of the operation of the pins and peripherals according to the program that is currently being 

executed.  

4. To pause the program execution, press the  button, and to perform step execution, press the  

button.   

* For the detailed use of PM+ and SM+, refer to the online document for each of these products.   

Click the simulator start button. 

Execution buttons 

Source window I/O panel  
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8. PG-LPC FLASH PROGRAMMING SOFTWARE 
 

8.1 Starting up GUI Software 
 

• GUI software startup 
 Select PG-LPC.EXE from the start menu to start the PG-LPC GUI software. 

 

 When the GUI software is started normally, the following screen appears. 
 

 

 

 
 

Figure 8-1.  PG-LCP GUI Software Main Window 

 

 

Menu bar 
Programmer 
parameter window 

Toolbar 

Action log window 

Status bar 
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This window consists of the following items: 

 

Table 8-1.  Window Names and Functions 

Name Display Information 

Menu bar 

(displayed at the top) 
Displays menu items executable by the PG-LPC. 

Toolbar 

(displayed under the menu bar) 

Displays frequently used commands as 
icons. 

Action log window 

(displayed under the toolbar) 
Displays an PG-LPC action log. 

Programmer parameter window 

(displayed to the right of the action log window) 
Displays programming parameter settings. 

Status bar Displays status. 

 

 

8.2 Toolbar 
The toolbar contains buttons for starting the important procedures of the PG-LPC. 

 

Table 8-2.  Toolbar Buttons 

 
[Device] → [Setup] button 

 
[File] → [Load] button 

 
[Device] → [Blank Check] button 

 
[Device] → [Erase] button 

 
[Device] → [Program] button 

 
[Device] → [Autoprocedure(EPV)] button 
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8.3 Menu Bar 
Depending on the actual device status and device type, some menu items may be enabled or disabled. 

 

8.3.1 [File] menu 

Clicking the [File] menu displays the pull-down menu as shown below. 

This menu mainly contains commands related to file operation. 

 

 

Figure 8-2.  [File] Menu 

 

(1) [Load] command 

The [Load] command allows you to select a program file. 

The selected program file is programmed into the flash memory of the device by executing the 

[Program] command or [Autoprocedure(EPV)] command. 

 

 

Figure 8-3.  HEX File Selection Window 

 

The file selection window for program loading displays the most recently used directory to which a user 

program has been loaded.  After a user program is loaded, a checksum calculation is made and the result is 

displayed in the programmer parameter window. 

[  Open  button] 

Selects a user program as a program to be written to the target device. 

 

[  Cancel  button] 

Closes the window without selecting a program. 
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(2) [Quit] command 

The [Quit] menu is the command for terminating the PG-LPC GUI software.  Clicking  ×  on the right side of 

the task bar also terminates the PG-LPC GUI software. 

User settings are saved in the PG-LPC.ININote file, so that the GUI software starts up next time with the same 

settings. 

 

Note PG-LPC.INI is created in the Windows folder when Windows 98SE, Windows Me, or Windows XP is 

used. 

 When Windows 2000 is used, PG-LPC.INI is created in the WinNT folder. 

 

8.3.2 [Device] menu 

Clicking the [Device] menu displays the pull-down menu as shown below. 

This menu mainly contains commands for programming operations such as blank check, deletion and 

programming of the target device. 

 

 

Figure 8-4.  [Device] Menu 

 

(1) [Blank Check] command 

The [Blank Check] command allows you to make a blank check on the 78K0S/KA1+ target device 

connected to the PG-LPC.  If the flash memory of the device is erased, a blank check is 

terminated normally.  If the flash memory is not completely erased, the indication “not blank” is 

provided.  Before starting programming, erase the flash memory of the target device. 

 

(2) [Erase] command 

The [Erase] command erases the flash memory of the 78K0S/KA1+ device connected to the PG-

LPC.  While the flash memory is being erased, the progress status is displayed in the action log 

window to indicate programmer operation. 

The execution on the [Blank Check] command before the [Erase] command is executed follows the setting of 

‘Command options’ of the Advance tab displayed by selecting [Device] → [Setup]. 

Upon completion of [Erase] command execution, the GUI software displays the result of executing the 

command on the target device. 

 

 



78K0S/KA1+ – Do it!  

User’s Manual  U17514EJ2V0UM 51

 

(3) [Program] command 

The [Program] command sends a specified user program to the target device and writes the 

program to the flash memory. 

The execution of Verify operation for detecting an error in user program communication from the 

PG-LPC to the target device after the execution of the [Program] command follows the setting of the 

‘Command options’ on the Advance tab displayed by selecting [Device] → [Setup]. 

During programming, the progress status is displayed in the action log window to indicate programmer 

operation.  This progress status display window displays the progress status on target device programming by 

percentage. 

Upon completion of [Program] command execution, the GUI software displays the result of executing the 

command on the target device. 

 

(4) [Verify] command 

This command is not supported. 

 

(5) [Security] command 

This command is not supported. 

 

(6) [Checksum] command 

The [Checksum] command reads the checksum value of the 78K0S/KA1+ device connected with the PG-

LPC.  This value differs from the value displayed in the parameter window of the main window. 

 

(7) [Autoprocedure(EPV)] command 

The [Autoprocedure(EPV)] command executes the [Erase] command and [Program] command in 

succession.  Upon completion of [Autoprocedure(EPV)] command execution, the GUI software 

displays the result of executing the command on the target device. 

 

(8) [Signature read] command 

This command is not supported. 
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(9) [Setup] command 

The [Setup] menu allows you to make settings related to flash memory rewriting according to the 

user environment and to set command options.  Each time the GUI software is started, the most 

recently used parameter file (.PRM) is read and the settings are displayed.  The [Setup] menu 

allows you to modify the settings of items other than those items consisting of shadowed characters according 

to the user environment. 

 

(a) Standard setup 

This menu is used to set the environment for rewriting the flash memory of the target device. 

The mode of communication with the target, the operating clock, and so forth differ depending on the 

device used.  The window shown below is opened. 
 

 

Figure 8-5.  Device Setup Window - Standard 

 

This window shows all basic options that can be set in accordance with the user environment and target 

device. 

 

[  OK  button] 

Clicking the  OK  button saves the settings on the Standard and Advance menus and closes the window. 

 

[  Cancel  button] 

Clicking the  Cancel  button closes the window without saving the settings on the Standard and Advance 

menus. 
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<1> Parameter file 

This file holds parameters and timing data required to rewrite the flash memory of the target device.  

Do not modify the data in the parameter file because the data is related to the guarantee of rewrite 

data. 

The parameter file is protected by the checksum function.  If the checksum result indicates an error, 

PG-LPC does not accept the parameter file. 

 

 

 

Figure 8-6.  Setup Window - Parameter File Selection 

 

 

 

Figure 8-7.  Parameter File Selection Window 

 

 

[  PRM File Read  button] 

A window for specifying a parameter file is displayed.  Specify a desired file then click  Open . 
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<2> Communication interface to device 

“Communication interface to device” is used to select a channel for communication between the 

78K0S/KA1+- Do it! board and host machine. 

 

 

Figure 8-8.  Setup Window - Communication Interface to Device 

 

[Port list box] 

Select a channel for communication between the 78K0S/KA1+- Do it! board and host machine. 

 

Remark Selectable ports can be checked using Device Manager.  For details, refer to 6.7 

Confirmation of USB Driver Installation. 

 

[Speed list box] 

Select a communication rate for the selected communication channel. 

 

<3> Supply oscillator 

“Supply oscillator” is used to select a clock that determines programming, data transfer, and a 

transfer rate. 

 

 

Figure 8-9.  Setup Window - Supply Oscillator Selection 

 

[Frequency box] 

Sets the clock frequency of the target system. 

The range of operating frequency varies from one device to another.  So, check the specifications 

of the device used before making a setting. 

 

[Multiply rate] 

Specifies the division rate or multiplication rate of the target device. 

If the target device has an on-chip PLL circuit, enter a division rate or multiplication rate according 

to the use environment. 

The selectable division rate or multiplication rate differs depending on the device.  Check the 

specifications of the device used before making a setting. 

If the target device does not have an on-chip PLL circuit, select “1.00”. 

On the initial screen, the default setting is displayed according to the parameter file. 
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<4> Operation Mode 

The setting of “Operation Mode” may divide the flash memory of some target devices into blocks or 

areas. 

This menu is used to select an operation mode of the flash memory.  Some devices do not have 

the block and area division modes, and some devices have only one of the modes.  In these cases, 

a nonexisting mode is unchoosable. 

 

 

Figure 8-10.  Setup Window - Operation Mode 

 

[When Chip is selected] 

The entire flash memory area of the target device is subject to rewrite processing. 

 

[When Block is selected] 

Specify the Block number range subject to rewrite processing by using Start/End. 

The Start/End list boxes display the Block numbers where the flash memory of the target device is 

configured. 

 

[When Area is selected] 

Specify the Area number range subject to rewrite processing by using Start/End. 

The Start/End list boxes display the Area numbers where the flash memory of the target device is 

configured. 

 

[Show Address check box] 

Specify whether numbers or addresses are displayed in the Start/End list boxes. 

If this check box is checked, addresses are displayed. 

If this check box is not checked, numbers are displayed. 
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(b) Advance setup 

The Advance setup menu is used to specify the command options and security flag settings. 

When “Advance” is clicked, the following window is displayed: 

 

 

Figure 8-11.  Device Setup Window - Advance 

 

<1> Command options 

This dialog box is used to specify the PG-LPC flash processing command options. 

 

 

Figure 8-12.  Setup Window - Command Options 

 

[Blank check before Erase check box] 

If this check box is checked, blank check is made before the Erase command or EPV command is 

executed. 

If the result of a blank check indicates OK, erase processing is not executed. 

 

[Security flag after Program check box]  Not usable 

 

[Checksum after Program check box] 

If this check box is checked, the flash memory checksum value of the target device is read from the 

target device after execution of the Program command and EPV command. 

 

This value differs from the value displayed in the parameter window of the main window. 
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8.3.3 [View] menu 

Clicking the [View] menu displays the pull-down menu shown below. 

This menu contains commands for setting whether to display the toolbar and status bar. 

 

 

Figure 8-13.  [View] Menu 

 

(1) [Toolbar] command 

Checking the [Toolbar] command displays the toolbar.  Unchecking the command hides the toolbar. 

 

(2) [Status Bar] command 

Checking the [Status Bar] command displays the status bar.  Unchecking the command hides the status bar. 
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8.3.4 [Help] menu 

Clicking the [Help] menu displays the following pull-down menu: 

 

 

Figure 8-14.  [Help] Menu 

 

(1) [About PG-LPC] command 

The [About PG-LPC] command opens the program entry window as shown below and indicates the version. 

Clicking  OK  terminates the display. 

 

 

Figure 8-15.  About PG-LPC Window 
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8.4 Programmer Parameter Window 
This window displays the settings of the programming parameters. 

 

 

Figure 8-16.  Programmer Parameter Window 

 

[Device] 

Updated after communication with the target device to display information about the target device. 

 

[Parameter file] 

Updated after [Setup] command execution to display information about a read parameter file. 

 

[Load file] 

Updated after [Load] command execution to select information about a selected program file. 

 
[Connection to device] 

Updated after [Setup] command execution to display information about the connection with the target device. 
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9. HOW TO USE PG-LPC FLASH PROGRAMMING SOFTWARE 
This chapter explains the basic operations of the PG-LPC GUI for programming the 78K0S/KA1+ - Do it! board.  

This chapter covers how to start the system, execute the EPV command, and program the target device 

µPD78F9222 mounted on the 78K0S/KA1+ - Do it! board. 

 

The conditions of the series of operations described in this chapter are as follows: 

 

Target board: 78K0S/KA1+ - Do it! 

Target device: µPD78F9222 

Clock: 8 MHz 

Voltage level: 5 V 

 

PG-LPC 

Parameter file: 78F9222.PRM 

Clock setting: 8 MHz  Multiplied by 1 

Port: COM4 (115200 bps) 

Operation mode: Chip 

Write HEX: Light_demo.hex  

Option setting: Blank check before Erase 

 

(1) Installing the PG-LPC GUI software 

Install the PG-LPC GUI software on the host machine you are using, by referring to (1) PG-LPC GUI software 

installation in chapter 9 (if the software has not been installed yet). 

 

(2) Installing the driver 

Install the USB driver on the host machine you are using, by referring to (1) PG-LPC GUI software installation 

in chapter 9 (if the driver has not been installed yet). 

 

(3) Installing the parameter file 

The parameter file for the µPD78F9222 device is installed automatically during installation of PG-LPC GUI, 

folder <PG-LPC install-path>\PRM.  The latest version of the parameter file (PRM78F9234) for the 

µPD78F9222 device can be downloaded from the following NEC Electronics microcontroller website. 

 

  http://www.necel.com/micro/ods/eng/index.html 

 

* Download PRM78F9234 by following [ParameterFile PG-FP4 PG-FPLx] and [ParameterFile PG-FP4 

 PG-FPLx For 78K0S Series] from Development tools download (ODS) (above URL).  
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(4) Connecting and starting 

 

<1> Set the 78K0S/KA1+ - Do it! board to the FLASH programming mode by switching SW3/S1 to ON.  The 

recommended configuration of connectors CN1, CN2 and CN12 is shown below: 

 

SW3 Setting  CN1 Jumper Setting 

S1 ON  1-2 Open 

S2 Don’t care  3-5 Shorted 

S3 Don’t care  4-6 Shorted 

S4 Don’t care    

 

 
 

 

CN12 Jumper Setting  CN2 Jumper Setting 

1-2 Shorted  1-2 Shorted 

3-4 Don’t care  3-4 Don’t care 

5-6 Don’t care  5-6 Don’t care 

7-8 Don’t care  7-8 Don’t care 

9-10 Don’t care  9-10 Don’t care 

Figure 9-1.  Setting for Flash Programming 

 

<2> <Plug and Play> Connect the 78K0S/KA1+ - Do it! board with the host machine via the USB cable. 
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<3> Start the PG-LPC GUI. 

 

 

Figure 9-2.  GUI Software Startup Screen 

 

(5) Setting the programming environment 

<1> Select [Device] → [Setup] from the menu bar. 

<2> The Standard dialog box for device setup is activated. 

 

 

Figure 9-3.  <Standard Device Setup> Dialog Box 
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<3> Click  PRM File Read  to open the parameter file selection window. 

 Select the parameter file “78F9222.prm” then click  Open . 

 

 

Figure 9-4.  Parameter File Selection 

 

<4> From the Port list box, select the communication port that matches the host machine being used.  Select 

the communication speed of the Host connection. 

 

 

Figure 9-5.  Port Selection 

 

Remark Selectable ports can be checked using Device Manager.  For details, refer to 6.7 

Confirmation of USB Driver Installation. 
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<5> Set “Supply oscillator” according to the specifications of the 78K0S/KA1+ - Do it! board,  

 “Frequency = 8.00 MHz” and “Multiply rate = 1.00”.  In “Operation Mode”, please specify the “Chip” 

mode.  The following figure shows the recommended settings: 

 

 

Figure 9-6.  <Standard Device Setup> Dialog Box After Setting 

 

<6> Switch to the Advance dialog box. 

 

 

Figure 9-7.  <Advance Device Setup> Dialog Box  

 

 <Command options>  

 Blank check before Erase:  Checked 
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<7> Click the  OK  button.  The GUI software sets the parameters. 

 When the settings have been completed, the following screen is displayed: 

 

 

Figure 9-8.  Completion of Parameter Setting 

 

(6) Selecting a user program 

<1> Select [File] → [Load]. 

<2> Select a program file to be written to the target device, then click  Open . 

 

 

Figure 9-9.  After Downloading 

 

The display is updated. 

“Success read HEX file.” is displayed. 

“PRM File Read OK.” is displayed. 

The display is updated. 
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(7) [Autoprocedure(EPV)] command execution 

Select [Device] → [Autoprocedure(EPV)] from the menu bar. 

When the [Autoprocedure(EPV)] command is executed, Blank Check → Erase → Program and FLASH 

Internal Verify are executed sequentially for the µPD78F9222 device. 

 

 

Figure 9-10.  After EPV Execution 

 

(8) Terminating the GUI 

Select [File] → [Quit] to terminate the GUI software.  All settings executed so far are saved in the 

PG-LPC.INI file, so that those settings can be reused when the GUI software is restarted. 

 

(9) Execute “LIGHT_DEMO” application 

Set the 78K0S/KA1+ - Do it! board to the normal operation mode by switching SW3/S1 to OFF. 

< Plug and Play> the 78K0S/KA1+ - Do it! board to start in normal operation mode. 

 

(10) Restarting the GUI 

When the system is restarted, the same screen as shown in Figure 54 appears. 

 

“...finish” is displayed. 
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10. TROUBLESHOOTING 
 

In driver installation, recognition based on Plug and Play is disabled. 

 

Cause: 

The USB connector may not be inserted normally into the USB port of the personal computer. 

Action: 

Check that the USB connector is inserted fully into the USB port of the personal computer. 

Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 

 

The driver file cannot be found at a specified location. 

 

Cause: 

The PG-LPC software of the 78K0S/KA1+ - Do it! board may not be installed correctly. 

Action: 

Install the GUI software again by referring to (1) PG-LPC GUI Software Installation in Chapter 7. 

 

In checking by Device Manager, “USB Serial Port” or “USB High Speed Serial Converter” is not displayed.  

Alternatively, the “!” or “×“ is prefixed. 

 

Cause: 

The USB connector may not be inserted normally into the USB port of the personal computer. 

Action: 

Check that the USB connector is inserted fully into the USB port of the personal computer. 

Alternatively, disconnect the USB connector from the USB port, then insert the USB connector again after a while. 

 

Cause: 

The driver may not be installed correctly. 

Action: 

<1> When this product is connected to the personal computer, right-click the driver marked with “!” or “×“. 

 Click  Erase  when displayed. 

<2> On Device Manager, execute [Hardware Modification Scan]. 

<3> Install the driver again with Plug and Play. 
 

Cause: 

The device may not be recognized (in the case of connection with the USB hub). 

Action: 

Try the following: 

•  Disconnect the USB connector, then insert the USB connector again. 

•  Connect the USB connector to another port of the USB hub. 

If the same symptom occurs, do not use the USB hub, but directly connect the connector to the USB port of the 

personal computer. 

 

When this product is connected with a personal computer, the “Add New Hardware Wizard” screen is displayed. 
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Cause: 

If the USB connector of this product is inserted not into the USB port used at the installation time but into another 

USB port, this product may be recognized as a new hardware item. 

Action: 

Install the driver by referring to 6.6 Driver Installation. 
 

Communication with the 78K0S/KA1+ - Do it! board is disabled. 

 

Cause: 

The driver may not be installed correctly. 

Action: 

Check if “USB Serial Port” and “USB High Speed Serial Converter” are installed correctly by referring to 6.6 Driver 

Installation. 
 

Cause:   

The COM port may not have been correctly set.   

Action:  

Using the Device Manager, the virtual COM port setting must be changed. Change the settings to appropriate 

values using the following procedure.  

1. Open the Device Manager. Select the USB Serial Port(COM?) from the ports (COM and LPT), and open the 

Properties.   

2. Once the Properties window is displayed, select the PortSetting tab and click the [Advanced] button to display 

the Extended Settings window.   

3. Once the Extended Settings window is displayed, change the Latency Timer (ms) setting in BM Options to 16, 

and then click [OK].  

4. Click the [OK] button to close COM Port Properties, and close the Device Manager window.   

* If communication is not possible even after the above settings have been performed, try again by changing the 

Latency Timer (ms) setting to a different value.   
 

Cause: 

The Port list box may not be set correctly. 

Action: 

Set the port checked using Device Manager. 
 

Cause: 

The power, clock or reset signal may not be supplied to the 78K0S/KA1+ device correctly. 

Action: 

<1> Check that the clock is supplied to the 78K0S/KA1+ device, connector CN1. 

<2> Check that the power is supplied to the 78K0S/KA1+ device, connector CN12. 

<3> Check that the CPLD reset signal is supplied to the 78K0S/KA1+ device, connector CN2. 
 

Cause: 

The PRM file selected in [Device Setup] may be incorrect. 

Action: 

Use the 78F9222.prm that matches the 78K0S/KA1+ - Do it! target device.  For information about the PRM file, 

refer to chapter 8 PG-LPC FLASH PROGRAMMING SOFTWARE. 
 

Cause: 

The setting of “Supply oscillator” in [Device Setup] may be incorrect. 

Action: 

Make a correct setting according to the specifications of the target device. 
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11. SAMPLE PROGRAMS 
The supplied CD-ROM includes five sample programs. Source programs and project files can be downloaded from 

the NEC Electronics Microcomputer website (http://www.necel.com/micro/index_e.html).   

 

Table 11-1.  Sample Program List   

Sample Program Name Folder Name Description 

Light demo Light_Demo This demonstration provides 8 types of light shows using 4 LEDs. The interval 

timer setting and LED control methods can be learned wit this demo. 

ADC demo ADC_Demo This demonstration realizes a simple voltmeter using variable resistors and 

analog input. It is suitable for learning the A/D converter setting method, etc. 

Reaction time demo ReacTime_Demo This demonstration measures the reaction time of the user, by measuring the 

time taken by the user to press a button after LEDs light as a start signal. 

Timer demo Timer_Demo This demonstration realizes a darkroom timer using two timers. The user is 

notified about the fact that the set exposure time has lapsed by a flashing LED.  

UART demo UART_Demo This demonstration performs data transmission/reception to/from a PC using 

UART. It displays the measurement data of a voltmeter realized using variable 

resistors with terminal software on a PC.   

 

In addition to source files, project files for NEC Electronics’ integrated development environment PM+ are 

included.  

Object code can be regenerated as needed. For how to use PM+, refer to chapter 7 or the PM+ User’s Manual.   

Do it! is shipped with the light demo programmed.  
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11.1 Light Demo 
This sample programs plays one of eight predefined lightshows.  After the program-start-signal, the program plays 

the first lightshow.  By pressing button SW1 the next show is selected.  Pressing button SW2 restarts the application. 

 

Table 11-2.  Peripherals and External Parts Used for Light Demo 

Used Internal Peripherals Used External Parts 

Timer80 LEDs D1-D4 

 Button SW1 

 Button SW2 

 

To run the Light demo set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to the following: 

 

SW3 Setting  CN1 Jumper Setting 

S1 OFF  1-2 Open 

S2 OFF  3-5 Shorted 

S3 OFF  4-6 Shorted 

S4 OFF    

 

 
 

 

CN12 Jumper Setting  CN2 Jumper Setting 

1-2 Shorted  1-2 Shorted 

3-4 Don’t care  3-4 Shorted 

5-6 Don’t care  5-6 Shorted 

7-8 Don’t care  7-8 Don’t care 

9-10 Don’t care  9-10 Don’t care 

Figure 11-1.  Settings for Light Demo 
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The same program operation as Do it! can be simulated using SM+.   

 

Click  File  -  Open Workspace  in PM+ and select Light_demo.prj under the Light_Demo folder. The following 

screen is displayed when SM+ is started. (For the SM+ startup method, refer to section 7.2.) 

Since program download and I/O panel settings have been done in advance, the operation of the Light Demo can 

be verified by executing the demonstration as is on SM+.  

 

 
 

Figure 11-2.  11-2. SM+ Screen (Light_demo)  

 

<1> Press the [Go] or [Restart] button to execute the program.  

<2> The fist type of light show starts.  

<3> The type of light show changes each time SW1 is pressed.  

<4> The entire system is reset every time SW2 is pressed, and the light show of step <2> above starts again.   

<5> Stop the program to end the demo.   

 

* If the I/O panel’s buttons do not operate, this may be because the object selection mode is selected (in which 

case the mouse cursor shape is an arrow). Change the mode to the input simulation mode (so that the mouse 

cursor shape is a hand) and try again.  

 

<1> 

<2> 

<3> <4> 
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11.2 ADC Demo 
This sample program simulates a simple voltage meter.  By using the integrated ADC, the voltage supplied to ADC 

on input channel 0, port P20/ANI0, is measured.  The input voltage is adjusted by potentiometer R24.  The board 

shows the measured voltage by flashing LEDs D1 to D4.   

 

Table 11-3.  Peripherals and External Parts Used for ADC Demo 

Used Internal Peripherals Used External Parts 

Timer80 LEDs D1-D4 

A/D converter Potentiometer R24 

 Button SW2 

 

To run the ADC demo please set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to the 

following: 

 

 
SW3 Setting  CN1 Jumper Setting 

S1 OFF  1-2 Open 

S2 OFF  3-5 Shorted 

S3 OFF  4-6 Shorted 

S4 OFF    

 

 
 

 

CN12 Jumper Setting  CN2 Jumper Setting 

1-2 Shorted  1-2 Shorted 

3-4 Shorted  3-4 Shorted 

5-6 Shorted  5-6 Don’t care 

7-8 Don’t care  7-8 Don’t care 

9-10 Don’t care  9-10 Don’t care 

Figure 11-3.  Settings for ADC Decmo 
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The same program operation as Do it! can be simulated using SM+.   

 

Click  File  -  Open Workspace  in PM+ and select ADC_demo.prj under the ADC_Demo folder. The following 

screen is displayed when SM+ is started. (For the SM+ startup method, refer to section 7.2.) 

Since program download and I/O panel settings have been done in advance, the operation of the ADC Demo can 

be verified by executing the demonstration as is on SM+.  

 

 
 

Figure 11-4.  SM+ Screen (ADC_demo)  

 

<1> Press the [Go] or [Restart] button to execute the program.  

<2> Move the level gauge to a suitable position.   

<3> The LED lights according to the position of the level gauge.   

<4> To reset KA1+, press SW2.   

 (Note: At this time, the LED does not light unless the level gauge is set again.) 

<5> Stop the program to end the demo.  

 

* If the I/O panel’s buttons or the level gauge do not operate, this may be because the object selection mode is 

selected (in which case the mouse cursor shape is an arrow). Change the mode to the input simulation mode 

(so that the mouse cursor shape is a hand) and try again.  

 

 

<1> 

<3> 

<2> 
<4> 
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11.3 ReacTime Demo 
This sample program demonstrates a reaction time measurement.  The application starts by flashing LEDs D1-D4 

two times.  After a press of button SW1 the application waits for a random time between 0.50 and 3.45 seconds.  

Then LED D4 is switched on and measurement starts by incrementing a reaction counter every 50ms.  The actual 

counter value is shown by LEDs D1-D4 (binary format) until the next keystroke of button SW1.  After a press of button 

SW1 is detected, the measurement stops and the reaction time is shown by flashing LEDs D1-D4.  The binary format 

is read (for example, in the case of D1: OFF, D2: ON, D3: OFF, D4: ON, 0101 = 5), and this value multiplied by 50 ms 

is your reaction time.  Pressing button SW2 starts a new measuring cycle. 

 

Table 11-4.  Peripherals and External Parts Used for ReacTime Demo 

Used Internal Peripherals Used External Parts 

Timer80 LEDs D1-D4 

TimerH1 Button SW1 

 Button SW2 

 

To run the ReacTime demo set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to the 

following: 

 

SW3 Setting  CN1 Jumper Setting 

S1 OFF  1-2 Open 

S2 OFF  3-5 Shorted 

S3 OFF  4-6 Shorted 

S4 OFF    

 

 
 

 

CN12 Jumper Setting  CN2 Jumper Setting 

1-2 Shorted  1-2 Shorted 

3-4 Don’t care  3-4 Shorted 

5-6 Don’t care  5-6 Shorted 

7-8 Don’t care  7-8 Don’t care 

9-10 Don’t care  9-10 Don’t care 

Figure 11-5.  Settings for ReacTime Decmo 
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The same program operation as Do it! can be simulated using SM+.   

 

Click  File  -  Open Workspace  in PM+ and select ReacTime_demo.prj under the ReacTime_Demo folder. The 

following screen is displayed when SM+ is started. (For the SM+ startup method, refer to section 7.2.) 

Since program download and I/O panel settings have been done in advance, the operation of the Reaction Time 

Demo can be verified by executing the demonstration as is on SM+.  

 

 
 

Figure 11-6.  SM+ Screen (ReacTime_demo)  

 

<1> Press the [Go] or [Restart] button to execute the program. (All the LEDs flash twice.)  

<2> Press SW1. After the lapse of a random length of time (0.5 s to 3.45 s), the LEDs start lighting up.   

 First, D4 lights up and the counter value is incremented in binary format every 50 ms, with D1 lighting up 

last, upon which measuring ends (during this time, press SW1 again.) 

<3> If SW1 is pressed during the measurement period, measuring is interrupted. (This yields your reaction time.)  

<4> Pressing SW2 resets KA1+.   

<5> Stop the program to end the demo.   

 

* If the I/O panel’s buttons do not operate, this may be because the object selection mode is selected (in which 

case the mouse cursor shape is an arrow). Change the mode to the input simulation mode (so that the mouse 

cursor shape is a hand) and try again.  

 

Note The SM+ operation time differs from that of Do it!, so that it does not match the actual reaction time.  

 

 

<1> 

<2>, <3> <4> 
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11.4 Timer Demo 
This sample program simulates a darkroom timer.  The board starts after reset flashing all LEDs. 

After the first time the SW1 key is pressed, the board starts counting the exposure time in units of one minute 

(binary output format), so select an appropriate time.  By pressing SW1 a second time the shown elapse time is 

selected and counting is started. 

After the selected time is finished the elapse time is displayed by flashing the LEDs twenty times and the stop 

mode is entered.  The stop mode can be released by pressing SW1, so that simulation can be performed again. 

 

Table 11-5.  Peripherals and External Parts Used for Timer Demo 

Used Internal Peripherals Used External Parts 

Timer80 LEDs D1-D4 

TimerH1 Button SW1 

 Button SW2 

 

To run the Timer demo please set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to the 

following: 

 

SW3 Setting  CN1 Jumper Setting 

S1 OFF  1-2 Open 

S2 OFF  3-5 Shorted 

S3 OFF  4-6 Shorted 

S4 OFF    

 

 
 

 

CN12 Jumper Setting  CN2 Jumper Setting 

1-2 Shorted  1-2 Shorted 

3-4 Don’t care  3-4 Shorted 

5-6 Don’t care  5-6 Shorted 

7-8 Don’t care  7-8 Don’t care 

9-10 Don’t care  9-10 Don’t care 

Figure 11-7.  Settings for Timer Demo 
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The same program operation as Do it! can be simulated using SM+.   

 

Click  File  -  Open Workspace  in PM+ and select Timer_demo.prj under the Timer_Demo folder. The following 

screen for starting PM+ is displayed as a result. (For the SM+ startup method, refer to section 7.2.)  

Since program download and I/O panel settings have been done in advance, the operation of the Timer Demo can 

be verified by executing the demonstration as is on SM+.  

 

 
 

Figure 11-8.  SM+ Screen (Timer_demo)  

 

<1> Press the [Go] or [Restart] button to execute the program. (All the LEDs flash continuously.)  

<2> Press SW1. The exposure time setting counter is incremented sequentially in binary format from D4. (The 

setting time unit is one minute.)   

<3> Press SW1 again to set the exposure time and start time measurement.   

 (The LEDs light in the sequence of D4→D3→D2→D1→D4→… during counting.) 

 When the set exposure time has elapsed, the LED to which the exposure time was specified flashes 20 

times and then stops.   

<4> Press SW2 to reset KA1+.   

<5> Stop the program to end the demo.   

 

* If the I/O panel’s buttons do not operate, this may be because the object selection mode is selected (in which 

case the mouse cursor shape is an arrow). Change the mode to the input simulation mode (so that the mouse 

cursor shape is a hand) and try again.  

 

Note The SM+ operation time differs from that of Do it!, so that it does not match the actual exposure time.  

 

<1> 

<2>, <3> <4> 
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11.5 UART Demo 
This sample program simulates a voltage meter with serial communication channel.  The sample program does a 

cyclic measurement of the input voltage of AD converter channel 0, port P20/ANI0, and transfers the measured result 

via UART6 to a terminal program running on the host machine.  The data transfer speed is set to 115200 bps by 

default.  The input voltage can be changed by potentiometer R24. 

 

Table 11-6.  Peripherals and External Parts Used for UART Demo 

Used Internal Peripherals Used External Parts 

Timer80 LEDs D1-D4 

A/D converter Button SW2 

UART6  

 

To run the UART demo please set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to the 

following: 

 

SW3 Setting  CN1 Jumper Setting 

S1 OFF  1-2 Open 

S2 ON  3-5 Shorted 

S3 OFF  4-6 Shorted 

S4 OFF    

 

 
 
 

CN12 Jumper Setting  CN2 Jumper Setting 

1-2 Shorted  1-2 Shorted 

3-4 Shorted  3-4 Shorted 

5-6 Shorted  5-6 Don’t care 

7-8 Shorted  7-8 Don’t care 

9-10 Shorted  9-10 Don’t care 

Figure 11-9.  Settings for UART Demo 

 

Here, HyperTerminal which comes with Windows is used as the terminal program for illustrative purposes.   

HyperTerminal can be started by selecting  Programs  -  Accessories  -  Communication  -  HyperTerminal  from 

the start menu.   
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When HyperTerminal is started for the first time, messages prompting the execution of various initial settings are 

displayed, so perform these settings accordingly.  

 

Figure 11-10.  Connection Settings (1)  

 

If at this time, Do it! is connected to a PC, virtual port (in this case, COM4) is listed as the connection destination, 

so select it.   

 

Figure 11-11.  Connection Settings (2)  

 

When a virtual port is selected, the properties dialog box is automatically opened, so perform the appropriate 

communication settings.   

Here, let’s perform the settings according to the factory default settings of Do it!  

 

Figure 11-12.  COM Properties Window   
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Once the initial settings have been completed, HyperTerminal starts.   

Here, let’s press SW2 (RESET) to display the following key input wait screen.   

 

 

Figure 11-13.  Terminal Window (1)  

 

Pressing a suitable key (for example, the [Enter] key) on the PC causes voltage measurement to start, and the 

measured voltage is displayed on the HyperTerminal screen via UART of KA1+ and the virtual port of the PC.   

 

 

Figure 11-14.  11-14. Terminal Window (2)  

 

Here, changing the variable resistor (R24) of Do it! allows the user to monitor the moment-by-moment changes in 

the voltage value.   
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The same program operation as Do it! can be simulated using SM+.   

 

Click  File  -  Open Workspace  in PM+ and select UART_demo.prj under the UART_Demo folder.  The following 

screen is displayed when SM+ is started. (For the SM+ startup method, refer to section 7.2.) 

Since program download and I/O panel settings have been done in advance, the operation of the UART Demo can 

be verified by executing the demonstration as is on SM+.  

 

 
 

Figure 11-15.  SM+ Screen (UART_demo)  

 

<1> Press either the [Go] or the [Restart] button for program execution. As a result, the set character string data 

is transmitted from the KA1+ side and the key input wait status is entered.   

 (The transmit/receive data can be checked in the log display area in the top right serial window.)  

<2> Following the selection of the dummy data for key input set to the serial editor area, press the [Transmit] 

button. Following data transmission from external (following reception for the KA1+ side), data transmission 

starts again from the KA1+ side.  

<3> By moving the level gauge, the voltage level is displayed by LED according to the selected level gauge 

position, and at the same time the voltage level data is transmitted to external via UART.   

 (The data under transmission can be checked in the log display area in the serial window.)  

<4> Stop the program to end the demo.    

 

* If the I/O panel’s buttons do not operate, this may be because the object selection mode is selected (in which 

case the mouse cursor shape is an arrow). Change the mode to the input simulation mode (so that the mouse 

cursor shape is a hand) and try again.  

 

<1> 

<3> 

<2> 
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12. CONNECTORS AND CABLES 
 

12.1 USB Host Connector CN7 
 

1 5

 

Figure 12-1.  Connector CN7, USB Mini-B Type Host Connector Pin Configuration 

 

 

Table 12-1.  Pin Configuration of USB Connector CN7 

USB Connector CN7 Signal Name 

1 VBUS 

2 DM 

3 DP 

4 N.C. 

5 GNDBUS 

 

For connection with the host machine, use a USB cable (Mini-B type).  For confirmation, NEC Electronics used 

only the USB cable delivered with the 78K0S/KA1+ - Do it! board. 
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12.2 USB Interface Cable (Mini-B Type) 
 

 

Figure 12-2.  USB Interface Cable (Mini-B Type) 
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13. SCHEMATICS 

 

Figure 13-1.  78K0S/KA1+ - Do it! Board Schematics 

Remark Schematics also available on CDROM directory  

 file “LPCDOIT_BOARD_SCHEMATICS.pdf” 
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